# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disclaimer</td>
<td>3</td>
</tr>
<tr>
<td><strong>Building a Process Model</strong></td>
<td>4</td>
</tr>
<tr>
<td>Build the Organization Chart</td>
<td>5</td>
</tr>
<tr>
<td>Create the Organization Page</td>
<td>6</td>
</tr>
<tr>
<td>Create the Organization Chart</td>
<td>6</td>
</tr>
<tr>
<td>Link the Organization Units</td>
<td>7</td>
</tr>
<tr>
<td>Open the Resources Page</td>
<td>7</td>
</tr>
<tr>
<td>Create a Role</td>
<td>8</td>
</tr>
<tr>
<td>Add the Resources</td>
<td>8</td>
</tr>
<tr>
<td>Adding Phone Number and E-mail to a Resource</td>
<td>9</td>
</tr>
<tr>
<td><strong>Build the Process Hierarchy</strong></td>
<td>10</td>
</tr>
<tr>
<td>Overview of Process Hierarchy</td>
<td>10</td>
</tr>
<tr>
<td>Create Top-Level Process Flow</td>
<td>11</td>
</tr>
<tr>
<td>Insert Top-Level Links</td>
<td>11</td>
</tr>
<tr>
<td>Break Down the Process Flow - Develop Job Description</td>
<td>13</td>
</tr>
<tr>
<td>Link the BPMN Shapes</td>
<td>15</td>
</tr>
<tr>
<td>Break Down the Process Flow - Initiate Recruitment</td>
<td>15</td>
</tr>
<tr>
<td>Break Down the Process Flow - Interview Candidates</td>
<td>18</td>
</tr>
<tr>
<td><strong>Review Process Inputs and Outputs</strong></td>
<td>19</td>
</tr>
<tr>
<td>Create the Materials Page</td>
<td>19</td>
</tr>
<tr>
<td>Add Materials to the Materials Page</td>
<td>20</td>
</tr>
<tr>
<td><strong>Define Inter-Process Links</strong></td>
<td>21</td>
</tr>
<tr>
<td>Define the Remaining Links</td>
<td>22</td>
</tr>
<tr>
<td>Create and Assign the Remaining Materials</td>
<td>24</td>
</tr>
<tr>
<td>Create a Flat Map</td>
<td>26</td>
</tr>
<tr>
<td>Assign Probabilities to Outputs of the Gateway Shape</td>
<td>27</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>--------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Verify Completed Process Map</td>
<td>28</td>
</tr>
<tr>
<td>Assign Process Properties</td>
<td>30</td>
</tr>
<tr>
<td>Assign Performers to BPMN Shapes</td>
<td>31</td>
</tr>
<tr>
<td>Make Properties Visible</td>
<td>33</td>
</tr>
<tr>
<td>Assign KPI's to your processes</td>
<td>35</td>
</tr>
<tr>
<td>Displaying Properties in a Separate Text Box</td>
<td>36</td>
</tr>
<tr>
<td>Generate the Function Flow Page</td>
<td>37</td>
</tr>
</tbody>
</table>
Disclaimer

Copyright (c) 2012 Interfacing Technologies Corporation. All rights reserved.

This document, as well as the software described in it, is furnished under license and may be used or copied only in accordance with the terms of such license. The content of this document is furnished for informational use only, and due to product development, this information is subject to change without notice, and should not be construed as a commitment by Interfacing Technologies Corporation. Interfacing Technologies Corporation assumes no responsibility or liability for any errors or inaccuracies that may appear in this documentation. Except as permitted by such license, no part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, recording, or otherwise, without prior written permission of Interfacing Technologies Corporation.

The Interfacing Technologies logo and Enterprise Process Center logo are trademarks of Interfacing Technologies Corporation.

Many of the designations used by manufacturers and sellers to distinguish their products are claimed as trademarks. Interfacing Technologies has made every effort to supply trademark information about manufacturers and their products mentioned in this publication. For the most up to date list, please refer to the Enterprise Process Center Online Help.
Building a Process Model

The following tutorial will take you through the basic steps in creating a simple process model using the Interfacing BPMN Modeler. The purpose of the tutorial is to illustrate some key modeling concepts and also to show you how to properly construct a process model.

The estimated time to complete the tutorial is 1½ to 2 hours. For the best results, try to complete the tutorial in a single session.

Model overview

We will call our simplified model “Hire New Employees”, which describes the process of recruiting and hiring a new employee.

Before the recruiting process can begin, the Human Resources department must verify that the job description is properly updated. Once this has happened, the job is posted to employees within the company as well as to the general public. Candidates are selected from the pool of applicants, and the Human Resources manager determines which candidate to hire after conducting job interviews.

Open and name a new drawing

1. From the Start menu, choose the option All programs > Interfacing BPMN Modeler for Visio > New BPMN Model. A drawing page entitled New Scenario opens. This is called the Scenario page and is always the first page of a model. If you are prompted, you will need to Enable Macros.

2. Right-click the blank page and select the option Properties. This opens the Custom Property Editor for the Scenario page.

3. The Scenario Name field is used to enter the name of the enterprise or top-level department you wish to model. Enter the name “Human Resources”.

4. The Description field is used to briefly explain the purpose of your model. Enter the text “Models the processing of hiring a new employee”.

5. Click OK.

Save the drawing

1. From the Visio toolbar, select File > Save.

2. The first time you save a drawing, the Save As window appears. Choose a location for the file.

3. Enter the desired file name.

4. Make sure that Drawing (*.vsd) is showing in the Save as type field. Select it from the drop-down if it is not displayed.

5. Click Save.
A complete business process model, to be analyzed properly, requires both an organization chart and a process hierarchy. The organization chart describes the departments, the Roles (i.e. roles or assets), and the resources that participate in the model. The process hierarchy is a sequence of linked activities that represent the flow of work through the model.

You can create a high-level map of a process without creating an organization chart. The Interfacing BPMN Modeler also lets you create your organization chart and add resources “on the fly” as you fill in process and activity details. For the purposes of this tutorial, we will begin by creating the organization chart and resources.

Build the Organization Chart

For the sake of simplicity, our organization consists of four units: a top-level Unit called "Human Resources", which represents the main department, and three sub-units called "Administration", "Recruitment", and "Network Systems". In this part of the tutorial you will learn how to create the Organization page, build an organization chart and define resources for the units in the organization.
Create the Organization Page

_On the Scenario page of our model:_

1. Right-click an empty area of the page.
2. Select **Create Organization Page**. The page is created and named automatically. When this procedure ends, you will be on the new **Organization** page.

_Move between the Organization and Scenario pages_

1. Locate the navigation tabs at the bottom of the page, to the left of the horizontal scroll bar.
2. Select the Scenario tab. This brings you to the Scenario page. You will see a rectangle named Organization, as well as a rectangle named Resources.
3. Right-click the Organization rectangle.
4. Select Go To Organization. You will return to the Organization page. (Double-clicking the Organization rectangle will also bring you to the Organization page.)

Create the Organization Chart

1. On the Organization page, double-click the default top-level organization unit named Enterprise.
2. When the Custom Property Editor opens, replace Enterprise with "Human Resources" as the name of the organization. Click OK. This shape will represent the top-level department in our model.
3. Drag the FS organization shape from the Scenario Advanced stencil and drop it onto the Organization page below and to the left of the Human Resources department. Call this unit "Administration".
4. Drop two other FS organization shapes onto the page and call them "Recruitment" and "Network Systems".

_Note:_ You can also open the **Custom Property Editor** if you right-click the shape and select **Properties**.
Link the Organization Units

1. Double-click the Administration organization to open the Custom Property Editor.
2. Select the ellipsis " ... " button in the Parent field.
3. Select Human Resources and click Assign Organization. The Human Resources is assigned as the parent of the Administration unit. Click OK.
4. Repeat these steps to link the Recruitment and Network Systems organizations to the Human Resources organization.

Your Organization page should now contain the following shapes:

![Organization Diagram]

Open the Resources Page

Before we can assign individuals (resources) to perform tasks in our model, we must define the Roles (i.e. roles or assets) and individual resources by creating them on the Resources page.

1. Select the Resources navigation tab at the bottom of the window.
2. The Resources page will be displayed.
Create a Role

In business process models, most activities can be performed either by an individual resource or by a Role (i.e. roles or assets). Defining Roles allows you to have activities performed by resource pools without specifying which member of the pool will actually perform the activity. Each role represents one resource pool.

To create a resource pool, you must create a role, as well as the individual members of that role, and then associate the members to an organization unit.

Add the Roles

1. From the Scenario Advanced stencil, drag the Role shape and drop it onto the Resources page.
2. In the Custom Property Editor, enter “Servers + Software” as the name of the role.
3. Click OK.
4. Repeat steps 1-3 to create two new roles named "HR Manager" and "Administrative Assistant".

Add the Resources

After you create the three new roles, you need to add resources and assign them to the existing types.

1. From the Scenario Advanced stencil, drag the FS resource shape and drop it onto the Resources page.
2. In the Custom Property Editor, enter “HR System” as the name of the resource.
3. Click the first ellipsis (...) button next to the Org field to open the Organization Selection dialog box. Select Network Systems from the list of available organizations. Click Assign Organization.
4. Click the Assign button next to the Roles field to open the Assign Roles dialog box.
5. Select Servers + Software from the list of available roles and click Assign. Users can select more than one role if necessary.
6. Click OK. The HR System resource is linked to the Servers + Software Role and the Network Systems organization.
7. Repeat steps 1-6 using the table below to add new resources:

<table>
<thead>
<tr>
<th>Resource Name</th>
<th>Assigned Role</th>
<th>Assigned Organization</th>
</tr>
</thead>
<tbody>
<tr>
<td>John Johnson</td>
<td>HR Manager</td>
<td>Recruitment</td>
</tr>
<tr>
<td>Brenda Brown</td>
<td>HR Manager</td>
<td>Recruitment</td>
</tr>
<tr>
<td>Tom Tompson</td>
<td>Administrative Assistant</td>
<td>Administration</td>
</tr>
</tbody>
</table>
Your Resources page should now resemble the following graphic. You may want to use the auto-layout function (right-click and select Layout This Page), or drag the shapes manually, to adjust the layout:

---

Your Organization page should now contain all of the following shapes. You may want to use the auto-layout function (right-click and select Layout This Page), or drag the shapes manually, to adjust the layout:

---

**Adding Phone Number and E-mail to a Resource**

You can enter the contact information associated with your resources, such as the phone number and e-mail address.

This can be done in the Custom Property Editor window, next to the phone number and e-mail fields.

Enter the phone number and email. Save your settings by selecting Apply and closing the window.
Build the Process Hierarchy

In this section of the tutorial you will learn how to build a process hierarchy consisting of business processes and BPMN shapes, as well as how to link them together to construct a logical process flow. You will also learn how to add certain properties to processes and BPMN shapes so that the flow of work is clear and easily communicated.

Overview of Process Hierarchy

Our *Hire New Employees* process shows the steps involved in hiring a new employee. In a business process model, each step (locate job description, verify accuracy, post internally/externally, receive applications, select candidates, interview candidates, offer position) is represented by a particular BPMN shape.

In large models, it is usually more convenient to group BPMN shapes logically into a series of separate sub-processes. This way, the process can be displayed at a high level overview, or in detail.
Create Top-Level Process Flow

Our Hiring Process contains three sub-processes called "Develop Job Description", "Initiate Recruitment", and "Interview Candidates".

Create top-level shapes

1. Go to the Scenario page.
2. From the BPMN stencil, drag the Process shape onto the Scenario page.
3. When the Custom Property Editor opens, enter "Hire New Employees" as the name of the process.
4. Click OK. A separate page is created for each process, and a process shape called Hire New Employees will be added to the Scenario page.
5. To see the new page created for this process, right-click Hire New Employees.
6. Choose Go To Process. You will jump to a blank page entitled Hire New Employees. We will use this page to lay out the rest of the process flow.
7. Add three processes to the Hire New Employees page. Enter the names "Develop Job Description", "Initiate Recruitment", and "Interview Candidates" respectively for these new processes.

Your Hire New Employees page should now look like this:

Insert Top-Level Links

From the Interfacing menu, select Interfacing Explorer. When the Interfacing Explorer window opens, note the process hierarchy, as shown below.
Links between processes are often called "Inter-Process Links", which must originate from a specific step within the source process, and link to a specific step within the destination process. Since we have not yet built the content contained without our sub-processes, for now we will simply link the process shapes at the top-level.

1. In the Interfacing Explorer, double-click Hire New Employees.
2. From the BPMN stencil, drag the FS process link shape to the Hire New Employees page and attach the source (left) end of the link right away (without releasing the mouse) to the output connector on the Develop Job Description shape. Then release the mouse.

3. The link’s Custom Property Editor appears. For now, we will not modify anything. Click OK to close the window. We will add Materials later on in the tutorial.
4. Attach the destination (right) end of the link to the input connector on the Initiate Recruitment process.
5. Repeat steps 2 and 3 to link the Initiate Recruitment process to the Interview Candidates process.
The Hire New Employees page should now look roughly like this:

![Hire New Employees Diagram]

**Break Down the Process Flow - Develop Job Description**

Completing the process flow requires breaking down each process into a series of specific steps. First, we will consider the process *Develop Job Description*. Let’s say that we have decided to model three activities in this process: locating the job description, evaluating the job description and modifying the job description. These activities are represented by tasks.

The process begins when Human Resources receives a request for a new employee from an outside department. This request becomes the trigger that initiates all subsequent activities. In a business process model, the starting point is usually represented by a start event. The start event is used when it is necessary to introduce new input that originates outside the model (from another department, in our case). Start events, in other words, represent incoming data, or occurrences, that trigger the flow of work within the process.

In our model, we will create a start event named “Receive notification” which will provide the input that sets all the other tasks in the model in motion. Consequently, a start event cannot accept incoming links from another activity within the model.

Here is how we proceed.

1. On the *Hire New Employees* page, right-click the *Develop Job Description* process shape and choose **Go To Process**. This brings you to a blank page entitled *Develop Job Description*.
2. From the *BPMN* stencil, drag the **Start** shape to the page.
3. When the *Custom Property Editor* opens, type “Receive notification” as the name of the event. Click **OK**. The shape is added to the page.
4. Right-click the shape and select **Message** to indicate the **type** of start event. The **Message type** indicates that some kind of message is being exchanged. In this case, the message is a request for new employees, from an outside department.
When it is necessary to represent an action that is being performed in a business process model, we use the Task shape.

1. From the BPMN stencil, drag the Task shape and drop it onto the page.
2. When the Custom Property Editor opens, enter “Locate Job Description” as the name of the task. Click OK. The shape is added to the page. Create two more tasks named "Evaluate Job Description" and "Write/Modify Job Description".

The next action we wish to model is the actual evaluation of the job description. If the job description is accurate, then it can be posted to the public. If not, it must be modified and re-evaluated. This represents a classic decision point that is sometimes referred to as an Exclusive Data-Based Gateway, or an XOR condition. This condition creates a split in the flow of work with mutually exclusive outcomes.

1. From the BPMN stencil, drag the Gateway shape and drop it onto the page.
2. When the Custom Property Editor opens, type “Job Description Acceptable?” as the name of the shape. Click OK. The gateway is added to the page.
3. Right-click the shape and select Xor to indicate the type of gateway.

When you have finished, your Develop Job Description page should look roughly like this:
Link the BPMN Shapes

Now that all of our process steps have been established, we must link the objects together in order to establish the flow of work between these steps.

1. From the BPMN stencil, select the FS process link shape and attach the source (left) end of the link to the output connector on the Receive Notification start event. The link’s Custom Property Editor appears.

2. For now, we will not modify anything. Click OK to close the window. We will add Materials later on in the tutorial.

3. Attach the destination (right) end of the link to the input connector on the Locate Job Description task.

Using the data in the table below, you should now be able to insert the remaining required links. Note that the source of a link is the shape from which the link originates. The destination of a link is the shape to which the arrowhead is attached.

<table>
<thead>
<tr>
<th>Source</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Locate Job Description&quot; task</td>
<td>&quot;Evaluate Job Description&quot; task</td>
</tr>
<tr>
<td>&quot;Evaluate Job Description&quot; task</td>
<td>&quot;Job Description Acceptable?&quot; gateway</td>
</tr>
<tr>
<td>&quot;Job Description Acceptable?&quot; gateway</td>
<td>&quot;Write/Modify Job Description&quot; task</td>
</tr>
<tr>
<td>&quot;Write/Modify Job Description&quot; task</td>
<td>&quot;Evaluate Job Description&quot; task</td>
</tr>
</tbody>
</table>

When you are finished, you may want to adjust the layout. Right-click a blank part of the page and select Layout this page. Your process should now look similar to this:

![Develop Job Description Diagram](Image)

Break Down the Process Flow - Initiate Recruitment

In this section we will add the steps for the Initiate Recruitment process. Choose the menu options Edit > Go To > Initiate Recruitment to move to the Initiate Recruitment page.
Let's assume that we have decided to model this process as follows: The secretary (Tom Tompson) receives the job description. He distributes the posting among the company's employees and sends the description to external job search websites. From the incoming job applications, qualified candidates are selected and contacted to schedule an interview.

1. From the BPMN stencil, drag three Task shapes to the Initiate Recruitment page and name them "Distribute Internally", "Distribute Externally", and "Select Candidates for Interview".

Once the job description is posted, job seekers will send their job applications to the company. Since the act of receiving job applications is more of an event than a task, we will model this using an Intermediate Event, with the type Message.

1. From the BPMN stencil drag the Intermediate shape to the Initiate Recruitment page.
2. When the Custom Property Editor opens, enter “Receive Job Applications” as the name of the new shape. Click OK.
3. Right-click the event and select Message to indicate the type of intermediate event.

When the secretary distributes the job description, he may or may not post it both internally and externally, however at least one of the aforementioned tasks are performed during a normal recruitment process. This split in the flow of work can be represented with a different kind of gateway, an Inclusive Gateway, also called an OR condition. This way, we will indicate that the job could be posted externally, or internally, or both.

1. From the BPMN stencil, drag the Gateway shape to the Initiate Recruitment page
2. When the Custom Property Editor opens, enter “Distribute JD Internally and/or Externally” as the name of the new gateway. Click OK.
3. Right-click the shape and select Or to indicate the type of gateway.

There are a couple of points that should be noted:

- Up to now we have modeled processes sequentially. That is, one activity ends before the next begins. By dividing the tasks of posting a job description internally and externally, we have introduced an example of possible parallel activities.
- In a business process model, when the flow of work divides among parallel activities, we must also determine whether the flow must then again merge. Gateways are also used to merge flows of work, as long as they are of the same type that was used to split the flow in the first place.
The final step in our *Initiate Recruitment* sub-process is to merge the flow of work after the job description has been posted, before the applications are received.

1. From the *BPMN* stencil, drag the **Gateway** shape to the *Initiate Recruitment* page.
2. When the *Custom Property Editor* opens, enter “Wait for completion of one or both tasks” as the name of the gateway. Click **OK**.
3. Right-click the shape and select **Or** to indicate the type of gateway.
4. Follow the instructions from the previous page to link the BPMN shapes according to the diagram below:

![Initiate Recruitment Diagram](image-url)
Break Down the Process Flow - Interview Candidates

We now have only one more process to model. Create the shapes illustrated in the screen shot below with the appropriate names and types. Use the previous steps to help you create the shapes.

There are two last shapes to add to this process. If the candidate is accepted after the interview, then the hiring manager will offer the position to the candidate. However, if the candidate is not suitable for the job, then the process will end immediately. These occurrences will be represented by end events.

End events are used to mark the final termination of a particular flow of work. In our model, the end shape indicates the end of the process of hiring new employees. An end shape with the type Message will represent the acceptance notification that is sent to the client. An end shape with the type Terminate will represent the candidate's rejection, since the hiring process will not continue past that point.

1. Create two End shapes with the names "Notify candidate of acceptance" and "Reject Candidate".
2. Right-click the "Reject Candidate" shape and select Terminate to indicate the type of event. Select the Message type for the remaining end shape.
3. Follow the instructions from the previous page to link the BPMN shapes according to the diagram below:

We have now completed the breakdown of processes for our model.
Review Process Inputs and Outputs

In order to complete the process map we need to represent the flow of work through the model. For this, we will use *Materials*, which represent the documents, pieces of data, or objects used within the flow of work. They can also be referred to as the inputs and/or outputs of BPMN shapes.

Each input or output of a BPMN shape must be represented by a Material attached to a process link. This link shape is directional: the way it is attached to a shape indicates the direction of the flow of work through the business process model.

First, let us consider the inputs and outputs of the various processes in our model. The following table summarizes these. (You may wish to review the tutorial step “Break down the process flow - Develop Job Description”.)

<table>
<thead>
<tr>
<th>Process</th>
<th>Input</th>
<th>Output</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop</td>
<td>Request for Employees</td>
<td>Job Description</td>
</tr>
<tr>
<td>Initiate Recruitment</td>
<td>Job description</td>
<td>Job Application</td>
</tr>
<tr>
<td>Interview Candidates</td>
<td>Job Application</td>
<td>Acceptance Notification</td>
</tr>
</tbody>
</table>

The flow of work in our model starts with HR receiving a notification that another department requires a new employee, and so we can say that *Request for Employees* is the input for the *Develop Job Description* process (as well as for *Hire New Employees*), and the job description is the output of that process. The job description is also the input of the process *Initiate Recruitment* which distributes the job descriptions and receives job applications. These job applications are the output of the process *Initiate Recruitment* and the input of the process *Interview Candidates*. At the end of the last process, two messages can be sent, an acceptance or a rejection notification. However, since the rejection notification leads to the *Terminate* end event (because the process does not, and could not, continue past that point), the only output of the process *Interview Candidates* is the acceptance notification.

Create the Materials Page

1. Go to the *Scenario* page.
2. Right-click and select *Create Material Page* from the pop-up menu.
3. The new *Materials* page will be displayed.
Add Materials to the Materials Page

A single material can have many states, meaning that one material may go through multiple transitions within a process. Here we will create the materials used in our processes, in all their various states.

1. From the Scenario Advanced stencil, drag the FS material shape and drop it onto the Materials page.
2. Enter "JobDesc" in the Name field.
3. Select Form from the Type drop-down list.
4. Enter "Approved" in the State field.
5. Click OK.
6. Repeat steps 1-5 using the table below to create new material objects.

<table>
<thead>
<tr>
<th>Material Name</th>
<th>Material Type</th>
<th>Material State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Req.Emp</td>
<td>Form</td>
<td>Received</td>
</tr>
<tr>
<td>Job App.</td>
<td>Form</td>
<td>Accepted</td>
</tr>
<tr>
<td>Accept Notice</td>
<td>Form</td>
<td>Created</td>
</tr>
</tbody>
</table>

Note: Material types are limited to Forms and Parts. For the purposes of this tutorial, materials are treated as forms, since they refer to various documents.

If the material state is not displayed, select Interfacing from the main toolbar and then select Interfacing Options... > Material State > Material State visible on material page. Select Update State to commit the changes and click OK.
Define Inter-Process Links

From the *Interfacing* menu, select *Interfacing Explorer*. When the *Interfacing Explorer* window opens, note the process hierarchy, as shown below.

Links between processes are often called "Inter-Process Links", which must originate from a specific step within the source process, and link to a specific step within the destination process. We will now define those source and destination steps for our inter-process links.

1. In the *Interfacing Explorer*, double-click *Hire New Employees*.
2. Double-click the link between the process *Develop Job Description* and the process *Initiate Recruitment*.
3. The link’s *Custom Property Editor* appears.
4. Click *Assign*. The *Material Selection* window appears.
5. Select *JobDesc; state: Approved* from the list and click *Assign*. Click *Apply* to commit the changes.
6. Select the button *Select Source Low Link*.
7. When the *Source Link Selection* window opens, select the gateway *Job Description Acceptable?* and click *OK*.
8. The *Destination Link Selection* window will open automatically. Select the gateway *Distribute JD Internally and/or Externally* and click *OK*.
9. Click *OK* to close the link’s *Custom Property Editor*. 

![Interfacing Explorer screenshot](image-url)
The *Hire New Employees* page should now look roughly like this:

![Hire New Employees Diagram](image)

If you examine the *Develop Job Description* page, you will see that a low-level link has been automatically inserted with the same name (and other properties) as our top-level link. You can drag the end event to its desired place on your page or you can right-click and select *Layout This Page*.

If you examine the *Develop Job Description* page, you will see that a low-level link has been automatically inserted with the same name (and other properties) as our top-level link. You can drag the end event to its desired place on your page or you can right-click and select *Layout This Page*.

![Develop Job Description Diagram](image)

A low-level link is also added to the *Initiate Recruitment* process.

![Initiate Recruitment Diagram](image)

Define the Remaining Links
We will now follow the same steps in the previous page to link the processes *Initiate Recruitment* and *Interview Candidates*.

1. Double-click the link between the process *Initiate Recruitment* and the process *Interview Candidates*.
2. The link’s *Custom Property Editor* appears.
3. Click *Assign*. The *Material Selection* window appears.
4. Select *JobApp; state: Accepted* from the list and click *Assign*. Click *Apply* to commit the changes.
5. Select the button *Select Source Low Link*.
6. When the *Source Link Selection* window opens, select the task *Select Candidates for Interview* and click *OK*.
7. The *Destination Link Selection* window will open automatically. Select the task *Conduct Interview* and click *OK*.
8. Click *OK* to close the link’s *Custom Property Editor*.

The *Hire New Employees* page should now look roughly like this:

```
Hire New Employees

Develop Job Description  JobDesc. Approved  Initiate Recruitment  JobApp. Accepted  Interview Candidates

The *Initiate Recruitment* page should now look roughly like this:

Initiate Recruitment

Develop Job Description

Distribute Internally

Distribute Internally and Externally

Receive Job Applications

Select Candidates for Interview

JobApp. Accepted

Interview Candidates

Distribute Externally```
The *Interview Candidates* page should now look roughly like this:

![Diagram](image)

Create and Assign the Remaining Materials

We've added inputs and outputs to the top level of our process. Now, we must also map the material flow between the individual tasks and events. To do this, we will go through each process and determine which materials are being exchanged, and their various states.

1. Open the *Develop Job Description* page and double-click the link between the tasks *Locate Job Description* and *Evaluate Job Description*.
2. In the *Material Name* field, click *Assign*.
3. Since we have not yet created the materials with the proper states used within the processes, we will create them as we go. In the *Material Selection* pop-up, click *Create New*.
4. In the *Name field*, enter "JobDesc". Select *form* from the *Type* field, and enter "Created" as the *State*. Click *OK*.
5. Select the newly created material and click *Assign*. Click *OK* to close the *Custom Property Editor*. 
6. Repeat steps 1-5 to create and/or assign the appropriate materials to the following links. Remember that all materials will be of the type \textit{form}:

<table>
<thead>
<tr>
<th>Process</th>
<th>Source</th>
<th>Destination</th>
<th>Material</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop Job Description</td>
<td>Evaluate Job Description</td>
<td>Job Description Acceptable?</td>
<td>JobDesc</td>
<td>Reviewed</td>
</tr>
<tr>
<td>Job Description Acceptable?</td>
<td>Write/Modify Job Description</td>
<td>JobDesc</td>
<td>Rejected</td>
<td></td>
</tr>
<tr>
<td>Write/Modify Job Description</td>
<td>Evaluate Job Description</td>
<td>JobDesc</td>
<td>Created</td>
<td></td>
</tr>
<tr>
<td>Receive Notification</td>
<td>Locate Job Description</td>
<td>Req.Emp</td>
<td>Received</td>
<td></td>
</tr>
<tr>
<td>Initiate Recruitment</td>
<td>Distribute Job Description</td>
<td>Distribute Internally</td>
<td>JobDesc</td>
<td>Approved</td>
</tr>
<tr>
<td></td>
<td>Distribute Job Description</td>
<td>Distribute Externally</td>
<td>JobDesc</td>
<td>Approved</td>
</tr>
<tr>
<td>Receive Job Applications</td>
<td>Select Candidates for Interview</td>
<td>JobApp</td>
<td>Received</td>
<td></td>
</tr>
<tr>
<td>Interview Candidates</td>
<td>Accept Candidate?</td>
<td>Reject Candidate</td>
<td>Reject.Notice</td>
<td>Created</td>
</tr>
<tr>
<td></td>
<td>Offer Position to Candidate?</td>
<td>Notify Candidate of Acceptance</td>
<td>Accept.Notice</td>
<td>Created</td>
</tr>
</tbody>
</table>
Create a Flat Map

The best way to understand the importance of accurate inter-process links is to generate a Flat Map page and examine the results.

1. Go to the Scenario page.
2. Right-click and choose the option Generate Flat Map Page.
3. In the Flat Map Start Point Selection window, select Hire New Employees as the starting point and click OK.
4. Please wait while the Flat Map page and diagram are created. This may take a few moments.

Your Flat Map page should look something like this:

![Flat Map - Hire New Employees](image)

The Flat Map allows you to view your process "end-to-end", meaning that all sub processes are expanded to display their contents, and are linked together according to the IPLs. This allows you to examine your process from beginning to end.
Assign Probabilities to Outputs of the Gateway Shape

In a business process model, each outcome of a task or event must have a probability of 100%. A 100% probability means that the outcome will occur every time the activity is performed.

A gateway is a special case, however. Recall that our exclusive gateway “Job Description Acceptable?” has two potential outcomes: 1) either the job description requires modifications, or 2) the job description is accepted. Since the outcomes of an exclusive gateway are mutually exclusive, we use probability values of less than 100% to determine which of the potential outcomes actually occurs each time the activity is performed. For a gateway only, the sum of the probabilities of all output links must equal 100%.

1. Go to the process page Develop Job Description.
2. Double-click the link connecting the shapes Job Description Acceptable? and Write/Modify Job Description.
3. When the Custom Property Editor opens, type the value "60.00" in the Probability field and click OK.
4. For the other link originating from the Job Description Acceptable? gateway; change its probability to "40.00".

On the process page Develop Job Description, the output links for the gateway are now displayed with the probability values 60% and 40%, indicating that in 60% of all cases, the job description requires some kind of modification.

Note: The new probability values have been propagated to the top-level links as well.
Verify Completed Process Map

The illustrations below show how your process pages should roughly look when using the *Layout This Page* function. Feel free to adjust the links and shapes to optimize the layout.
Once you select *Layout This Page*, articles can sometimes overlap in your process map. To give your map a more organized appearance, you can manually move the links between objects by simply clicking on the link and dragging it clear of the overlapping article. See example below:
Assign Process Properties

Each process should have an owner. The owner is either a role or resource that is responsible for most or all of the activities in the process. Multiple roles and/or resources can be assigned as process owners.

The following procedure for assigning a process owner assumes that you have defined your roles and resources. For the purposes of this tutorial, you will assign process owners after having built your processes; this information can also be defined while creating your model.

1. Go to the Scenario page.
2. Right-click the process shape Hire New Employees and select Properties to open the Custom Property Editor.
3. On the Basic tab, click Assign to the right of the Owner field.
4. In the Owner Selection window, select Servers + Software and click Assign.
5. Click OK to save your changes and close the window.

Go to the Hire New Employees page and assign the appropriate owners to the following processes:

<table>
<thead>
<tr>
<th>Process</th>
<th>Owner</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop Job Description</td>
<td>Administrative</td>
</tr>
<tr>
<td></td>
<td>Assistant</td>
</tr>
<tr>
<td>Initiate Recruitment</td>
<td>HR Manager</td>
</tr>
<tr>
<td>Interview Candidates</td>
<td>HR Manager</td>
</tr>
</tbody>
</table>
Assign Performers to BPMN Shapes

We must also add to our current model the name of the resource that performs each activity.

1. In the process *Develop Job Description*, open the Custom Property Editor for the task *Locate Job Description*.
2. Click Assign to the right of the Performers field.
3. In the Performer window select Resources and then the row *Tom Tompson*.
4. Click Assign. This returns you to the Custom Property Editor. The resource, *Tom Tompson*, appears in the Performers field.
5. Click OK to confirm the role/resource assignment and close the window.

To assign the remaining references to the appropriate shapes, we will use the Property Explorer, which is a much faster method. From the Visio toolbar, select **Interfacing > Property Explorer**. The Custom Property Editor will be displayed.

From this window, you can create or edit any object in the BPMN Modeler.

1. From the Hierarchy Explorer (the window in the top-left corner), navigate to the task *Evaluate Job Description* (*Process Hierarchy > Hire New Employees > Develop Job Description*).
2. Click Assign to the right of the Performers field.

In the Performer Selection window, click the Resource option. Select the resource *Brenda Brown*. Click Assign. You can assign another role or resource using step 3 if necessary. This can be done by re-selecting Assign.

3. The resource will be assigned to the task. Click Apply to commit the changes.
Assign the following resources to the remaining shapes. The table below lists the information you will need.

NOTE: You can also assign roles to shapes.

<table>
<thead>
<tr>
<th>Process</th>
<th>BPMN Shape</th>
<th>Resource Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Develop Job Description</td>
<td>Job Description acceptable?</td>
<td>Brenda Brown</td>
</tr>
<tr>
<td></td>
<td>Receive Notification</td>
<td>Brenda Brown</td>
</tr>
<tr>
<td></td>
<td>Write/Modify Job Description</td>
<td>Tom Tompson</td>
</tr>
<tr>
<td>Initiate Recruitment</td>
<td>Distribute Job Description</td>
<td>Tom Tompson</td>
</tr>
<tr>
<td></td>
<td>Distribute Internally</td>
<td>Tom Tompson</td>
</tr>
<tr>
<td></td>
<td>Distribute Externally</td>
<td>Tom Tompson</td>
</tr>
<tr>
<td></td>
<td>Wait for completion of one or both tasks</td>
<td>Tom Tompson</td>
</tr>
<tr>
<td></td>
<td>Receive Job Applications</td>
<td>HR System</td>
</tr>
<tr>
<td></td>
<td>Select Candidates for Interview</td>
<td>Brenda Brown</td>
</tr>
<tr>
<td>Interview Candidates</td>
<td>Conduct Interview</td>
<td>Brenda Brown</td>
</tr>
<tr>
<td></td>
<td>Accept Candidate?</td>
<td>John Johnson</td>
</tr>
<tr>
<td></td>
<td>Offer Position to Candidate</td>
<td>John Johnson</td>
</tr>
<tr>
<td></td>
<td>Notify Candidate of Acceptance</td>
<td>Tom Tompson</td>
</tr>
<tr>
<td></td>
<td>Reject Candidate</td>
<td>Tom Tompson</td>
</tr>
</tbody>
</table>
Make Properties Visible

Note: The performers you just assigned do not appear on the process pages. This is because we need to make this property visible.

1. Right-click the Develop Job Description page.
2. Choose the option Select Visible Properties.
3. When the Properties Display Selection window opens, select the properties Activity_Performer and Process_Owner.
4. Click the check box Apply Changes on All Pages.
5. Click OK. The name of the resource and/or role that performs the activity will now be displayed below the appropriate shape.

Your processes will now look similar to this:
Initiate Recruitment

Interview Candidates
Assign KPI’s to your processes

KPI stands for Key Performance Indicator. Typically, KPIs are time, cost or quality targets whose fulfillment determines the performance of a given process. You can create a KPI page using the Property Explorer. From the toolbar, select Interfacing > Property Explorer. The Custom Property Editor will be displayed.

We will now create our KPIs and add them directly to the appropriate processes.

1. From the Hierarchy Explorer (the window in the top-left corner), select **Hire New Employees**.
2. Select the **High Level** tab. Make sure that the K.P.I window is displayed.
3. Click **Add**. The message No KPI page was found. Do you wish to create one? will be displayed. Select **Yes**.
4. Select **Create New...** in the Key Performance Indicator window.
5. Enter “Average days to fill open positions” in the KPI Name field.
6. In the **Target** field, enter "30". Enter "0" in the **Start Value** field and "Day" in the **Unit** field. This means that it should take approximately 30 days to fill an average position. Select **OK**.
7. Select the newly created KPI and click **Assign**. The KPI will now be assigned to **Hire New Employees**. Click **Apply** to commit the changes.
8. Use the information in the table below to create three more KPIs for the appropriate processes:
### Displaying Properties in a Separate Text Box

The **FS Property** shape on the *Scenario Advanced* stencil can be used to display certain properties of BPMN shapes. The **FS Property** shape can be moved independently of any other shape.

1. Navigate to the *Scenario* page and drop the **FS Property** shape on the *Hire New Employees* shape. The *Property Selection* window will then open.
2. The *Property Selection* window always lists certain default properties. Additional properties are added to the list as you create the properties for a given process or activity shape. Select the property **KPI** and click **Assign**.
3. Repeat steps 1 and 2 to display the KPI values of the processes *Initiate Recruitment* and *Interview Candidates*.

### Hire New Employees

- **Develop Job Description**
  - 40% JobDesc. Approved
  - Administration

- **Initiate Recruitment**
  - Initiate Recruitment
  - JobApp. Accepted
  - Recruitment

- **Interview Candidates**
  - Interview Candidates
  - Recruitment
  - Ratio of acceptances to offers
  - Ratio of qualified applicants to total applicants
Generate the Function Flow Page

Now that the process hierarchy for our model is complete, we need to generate a Function Flow page that reflects the finished model.

Go to the Scenario page. Right-click and select Generate Flow Page. Use Hire New Employees as the starting point. The page should finally look something like the diagram shown below.

You'll notice that shapes are now arranged in "swimlanes" corresponding to the assigned owners and performers. Process links crossing over the boundaries between swimlanes indicate responsibility hand-offs between organization units.

NOTE: If an object has more than one owner, all the owners' organization units will be displayed in an appropriate lane once the Flow page has been generated.

This completes the tutorial.

Interfacing offers a number of additional features for the BPMN Modeler. Ready-to-use sample process maps based on best practice frameworks are available. Interfacing also offers BPMN, OCEB, and BPMN Modeler training programs at competitive prices. If you are interested in receiving sample process maps, or would like to take part in a training program, please contact: sales@interfacing.com.